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1.1	 Minimum Hardware requirements

•	 PC with Pentium 2 GHz or similar.

•	 1 GB RAM memory (XP).

•	 Video resolution 800 x 600, 256 colours.

•	 CD-ROM or DVD reader

•	 Hard Disk: 500 MB minimum free space available.

1.2	 Minimum Software requirements

•	 Windows XP SP2 (32 bit), Windows Vista (32 bit o 64 bit) or Windows 7 (32 bit o 64 bit)

•	 The .NET 3.5 SP1 framework is required for correct operation of the application.

•	 Minimum browser requirements for correct display of the web pages: Internet Explorer ver. 7, 
Firefox ver. 3, Chrome ver. 9, Safari ver. 4. 

•	 However, for the energy supervision function higher Internet Explorer requirements are neces-
sary: ver.8 + Google Frame plug-in or better.

The updated requirements can be found on the www.bticino.com website

To install the TiF453AV program proceed as described:
1.	Put the Cd-Rom into its drive.
2.	After the main page is displayed in the web format, select “Software” and then “Install TiF453AV”.
3.	The installation program will copy the system files needed to run the TiF453AV program.

1.	Hardware 
and Software 
requirements

2.	Installation

Warning: The TiF453AV 
software is the 
fundamental tool for 
the configuration of 
the F453AV Web Server, 
which, for convenience, 
will be referred to as 
device in this manual. This 
software is protected by 
exclusive rights, owned by 
the company BTicino SpA
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3.	Fundamental 
concepts

Attention: for the 
TiF453AV software 
to work correctly, the 
device must be installed 
in agreement with the 
indications given in the 
instruction sheet supplied 
with the device.

The TiF453AV software can create and edit a project containing the device configuration to manage 
My Home systems remotely.
The created project must be sent to the device. This is done by connecting the device to the PC us-
ing a “cross-over” cable connected to the device LAN connector and to the PC’s Ethernet card. As an 
alternative you can update the device remotely if you know the IP address and OPEN password (for 
more details see the user manuals supplied with the device).
In the same way the project file can be received from the device to check and/or edit the configura-
tion it contains.
The TiF453AV program also lets you update the version of the device’s permanent base software 
(firmware) by means of new revisions distributed by Bticino.

To create a new design

•	 Run TiF453AV.

•	 Make a new design.

•	 Send the data to the device

To edit an existing design

•	 Receive the current confi guration data from the device.

•	 Make any modifi cations.

•	 Send the data of the design made to the device

With TiF453AV you can update the device firmware version (Add fi rmware) with new revisions is-
sued by Bticino.

On opening the program, the start screen is displayed, which contains all the configuration param-
eters listed in hierarchical order. The configuration details are entered in the area on the right.

3.1	 Function selection menus and pushbuttons

Pull-down menus Pushbutton menu Data input area

Opens the Info 
and Errors area 

Navigation 
bar

Info and 
Errors area

Closes the Info 
and Errors area

Function 
description

Functions and parameters 
to be configured
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•	 New
Creates a new project

•	 Open
Opens an existing configuration file

•	 Save
Saves the current project

•	 Save as . . .
Saves the current project asking for a name for the file

•	 Exit
Exits the program

3.1.1	“File” menu 

All the functions which can be run with TiF453AV can be selected by means of the icons in the tool 
bar, or by opening the pull-down menus and selecting the various items.
The tool bar has the following options:

Creation, Open and Save configuration file

Receive, Send the configuration

Update device firmware

Selection of the application language

Connection to the www.bticino.com site

Request device info

The pull-down menu has the following options:
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•	 Language
Can select the application language

3.1.3	“Language” menu

3.1.4	“?” menu

•	 About . . .
Displays some information on the TiF453AV program

•	 Supported Version
In a table displays the devices firmware versions managed by the TiF453AV program

•	 Receive Configuration
Runs the upload function of the configuration from the device

•	 Send Configuration
Downloads the configuration to the device

•	 Update Firmware
Updates the device firmware

•	 Request device info
Displays the technical information

3.1.2	“Tools” menu
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To receive/send the configuration completed using the TiF453AV software, or to update the 
firmware, connect the device to the PC using a USB/miniUSB cable, the serial-USB adapter (3559), 
or an Ethernet cable.

3.2	 Connecting the device to a PC

Serial connection

USB USB

SCS
AV IN

SCS
AV OUT

SCS
AI DCSCS

AVETH

Speed Full Link Aux System

F453AV

3559

USB USB

SCS
AV IN

SCS
AV OUT

SCS
AI DCSCS

AVETH

Speed Full Link Aux System

F453AV

USB connection

Ethernet connection

2 3 4 5 61

DC - In

USB USB

SCS
AV IN

SCS
AV OUT

SCS
AI DCSCS

AVETH

Speed Full Link Aux System

F453AV
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It allows the user to send the project created to the device.

Procedure:
>> Connect the device to a PC as shown in the corresponding section.

>> From the Tools pull-down menu select Send Configuration.

The following window appears:

>> Click Next to display the window for the selection of the mode of connection with the device. 
The sending operation can be performed using three different types of connection:

•	 Ethernet: by entering the network address, or by automatic search.

•	 Serial: by selecting the port (COM), or through automatic detection.

•	 USB: through automatic detection of the connected items.

3.3	 Send the configuration
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In this mode the device is recognised automatically.

USB connection

Serial connection

Ethernet connection
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>> After clicking Next the project is transferred to the device.

Display the 
details of the 
current sending

It exports 
the log file

Hide the 
details of 
the current 
sending

Repeat the operation if unsuccessful

After selecting the connection mode, click Next to load the project currently installed on the 
device.

It allows the user to receive the configuration from the device; once the configuration has been 
acquired, this can be changed and saved, or it can be resent to the device.

Procedure:
>> Connect the device to a PC as shown in the corresponding section.

>> From the Tools pull-down menu select Receive Configuration.

A mask is displayed, for the selection of the mode of connection to the device (for the connection 
procedures see the Send the Configuration section).

3.4	 Receive the configuration
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3.5	 Update the Firmware

It allows the user to update the device firmware.

Procedure:
>> Connect the device to a PC as shown in the corresponding section.

>>  From the Tools pull-down menu select Update Firmware.

The following screen appears, prompting the user to search for the folder containing the firmware 
file with extension .fwz (compressed file).

3.6	 Request device info

It displays some information on the device connected to the PC.

Procedure:
>> Connect the device to a PC as shown in the corresponding section.

>> From the Tools pull-down menu select Request Device Info.

This action will open a mask for the selection of the mode of connection to the device (for the con-
nection procedures see the Send Configuration section).
After selecting the connection mode, click Next to open a screen showing the device hardware and 
software features.

>> Select the file and click Open to continue.

This action will open a mask for the selection of the mode of connection to the device (for the con-
nection procedures see the Send Configuration section).
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4.	Project 
configuration

This section can be used to configure a new project, or to change an existing one.

>> From the File menu select New.

The following window appears:

>> Enter the configuration data in the various sections.

4.1	 Network connections

The technical parameters for the network connections are configured in this section.
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4.1.1	Ethernet
Here we find the mask for entering the connection parameters to the Ethernet network.

If you want to enable the connection to the device via Ethernet network, the following items must 
be configured, or the default values used.

•	 Web server IP and Subnet mask
Typical parameters of networks with TCP/IP protocol. They are used to identify the device inside 
the local network. Remember that the device needs a “static” (fixed and unique) IP address to be 
able to work correctly.

•	 Router IP
Router IP address, if there is one. If there is a router the field must be filled in, to guarantee outgo-
ing Services, such as sending e-mail.

•	 Primary DNS and Secondary DNS
Primary and secondary IP address of the Internet Service Provider (ISP), supplied when the sub-
scription is taken out.

Before editing the default
values, contact the 
network administrator.
Incorrect values, as well 
as making the service 
inactive, could cause 
malfunctions in the  
communication of other 
network equipment.

4.2	 General parameters
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4.2.1	Clock
This function can define the local time zone and whether the device is the time synchronisation 
“Master”.
If it is set as Master clock, other devices in the My Home system use the internal clock of the device 
in programming as reference for the time.
The frequency of updating the time for all the devices can be selected in the box.

4.2.2	Univocal codes
This function gives an identification number to the gateway.
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4.2.3	Address
Enter the internal Post address. The field can assume values between 0 and 99.

4.2.4	Language
This function can select the language for the control web pages and remote system management.



TiF453AV U
se

r g
ui

de

17

4.3	 Security

This section is used to set the safety parameters.

4.3.1	Authentication
Web users
In this section you are asked to enter the name and password which the user will use for authentica-
tion, enabling and access to the services offered by the device selected.

The following must be defined in the mask:

•	 User Login and User password
Enter the user Login and Password (default: user.user)

•	 Administrator login and Administrator password
Enter the administrator Login and Password (default: admin.admin)
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4.3.2	Web session
The inactivity time on the web page, after which the device returns the user to the identification 
page, can be defined in this section.

•	 Web session timeout
Select the interval of inactivity on the web page from 1, 2, 5 or 15 minutes.

Automatic system

•	 OPEN Password
Enter the OPEN password whenever the device is used for remote control of the My Home system 
via programs for PC.

Safe cameras
Enable and enter a password to display the images sent by the cameras.

Attention: The default 
OPEN password in the 
devices is 12345.
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4.3.3	IP address enabling
This window can be used to enter up to 10 IP address ranges with connection to the device enabled, 
without the need for entering the login ID or password.

>> Enable the IP address.
>> Click  to enter the ranges.

4.3.4	Remote commands
This section is used to set the parameters for remote access adjustment.
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Remote access
Activate this function to, if required, disable remote connection to the device. This is done by setting 
the auxiliary channel from which the command is received.

OPEN commands  to be blocked
This function can be used, if required, to disable the forwarding of certain commands from the de-
vice. The definition of the forbidden commands (max. 20) is done by entering them in the appropri-
ate area, following the “Open Web Net” protocol.

The following must be defined in the mask:

•	 Activation/deactivation event
Enter the auxiliary channel dedicated to activating/deactivating the remote access.

•	 Signalling actuator
Enable a light point to use as signalling actuator.
The state of the connection can be displayed by the lighting up of a light signal controlled by 
an Automation system actuator; the configuration of this device must be given by setting the 
parameters in the box.

>> Click to enter the SCS address.
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On enabling the function a window to enter the commands is displayed.

There are two ways of compiling the command:

•	 Manual
allows direct entry of a command
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4.4	 Services

The web pages of the My Home applications are configured in this section.

4.4.1	Web pages
In this page the display of the sections corresponding to the My Home applications in the system 
can be enabled or disabled in the web pages.

All the pages of this section have a bar used for adding individual objects and pages.  Before adding 
an object, a page must be added.

Object management Page management

Add an 
object

Add a pageDelete all 
objects

Rename 
a page

Delete an 
object

Delete  
a page

Move objects

•	 Guided
The command can be defined automatically, selecting the configuration and type of command 
to be blocked in the menu.
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Scenarios
This section is used to define the objects for the activation of the scenarios managed by the central 
unit or the scenario module of the My Home system.
It is possible to configure up to 9 Web pages with 10 objects each, one of which at least correctly 
configured.

Click  to assign a description to the Web page (15 characters maximum).

After adding an object, a window appears where the user can enter the specific scenario data. 
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The following must be defined in the mask:

•	 Object description
Enter the description of the object – 15 characters max.

•	 Scenario Type
Select if the scenario is a Normal or a Plus scenario.

•	 Scenario address
Click to select the address of the scenario to perform, saved in a scenario module.

>> Click   in the Action field to select the scenario.

>> Click  in the Address field to select the address of the devices the scenario must be sent to.
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Lights
This section is used to define the objects that will be included in the “Lights” function web page.
It is possible to configure up to 9 Web pages with 10 objects each, one of which at least correctly 
configured.

After adding an object, a window appears, where the user can enter the specific lighting data. 
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Automation
This section is used to define the objects that will be included in the  “Automation” function web 
page.
It is possible to configure up to 10 Web pages with 10 objects each, one of which at least correctly 
configured.

After adding an object, a window appears where the user can enter the specific automation data. 

The following must be defined in the mask:

•	 Description
Enter the description of the object – 15 characters max.

•	 Address
Click to enter the SCS address

•	 Dimmer
Select Not Enabled or Dimmer 10/100 levels

•	 Timing
select Not enabled or ON (from 1 min to 0.5 sec)

•	 Blinking
select Not enabled or Blinking (from 0.5 sec to 5 sec)
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The following must be defined in the mask:

•	 Description
Enter the description of the object – 15 characters max.

•	 Address
Click to enter the SCS address.

Loads control
This page can be used to assign a description and the priority to the controlled loads that will be 
available in the “Load Control” Web page.
To re-enable a disconnected load following a tripping of the Energy Management central unit, it will 
be necessary to operate on the corresponding object displayed in the Web page.
The priority associated to the load is that defined when configuring the Power Management System 
by means of the numbered configurators (1 – 8) put into position CC of the actuators.

The following must be defined in the mask:

•	 Description
Enter the description of the object – 15 characters max.

•	 Priority
Enter the priority associated to the selected load.
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Temperature control
This section can be used to set the Temperature control system details.

System 99 zones
This section can be used to insert a 99 zone central unit and customise its description.
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Zones
For each of the 99 zones the configuration parameters must be entered.

Programs
For each of the two types of operation (winter/summer) up to 3 programs can be enabled and their 
description customised.

The following must be defined in the mask:
•	 Object description

Enter the description of the object – 15 characters max.
•	 Address

Enter the zone address.
•	 Management type

Enter the type of management performed (heating, cooling, or both).
•	 Fan-coil

Specify if the type of management performed is a Fan-coil type management

The following must be defined in the mask:
•	 Object description

Enter the description of the object – 15 characters max.
•	 Type

Enter the type of operation (summer/winter).
•	 Number

Enter the program number
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Scenarios
For each of the two types of operation (winter/summer) up to 16 scenarios can be enabled and their 
description customised.

System 4 zones
This section can be used to insert a 4 zone central unit and customise its description.

For the configuration of the “Zones” and “Programs” items see “System 99 zones”. For this type of 
central unit the scenario item is not included.

The following must be defined in the mask:
•	 Object description

Enter the description of the object – 15 characters max.
•	 Type

Enter the type of operation (summer/winter).
•	 Number

Enter the scenario number
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Not controlled zones
This section can be used to configure the zones not controlled by the central unit.

External probes
This section can be used to configure external probes.

The following must be defined in the mask:

•	 Object description
Enter the description of the object – 15 characters max.

•	 Address
Enter the zone address.

The following must be defined in the mask:

•	 Object description
Enter the description of the object – 15 characters max.

•	 Address
Enter the address of the external probe.
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Basic climate control
This section can be used to configure the AC units and the groups of commands that will be available 
in the temperature control/air conditioning function page. In the case of basic climate control, the 
management function is performed only through the 20 commands saved on the 3456 interface.

AC UNITS
This section can be used to configured the AC unit.

The following must be defined in the mask:

•	 Description
Enter the description of the object – 15 characters max.

•	 Address
Click to enter the 3456 interface address.

•	 Off address
Enter the number of the command configured as OFF on the 3456 interface.

•	 Probe enabled
Enable/disable the temperature probe.
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•	 Probe address
Click to enter the address of the slave probe

•	 Off
Enable/disable the Off command.

Favourite commands
Enter the favourite commands selected among the 20 available on the IRSplit for the management 
of the AC unit.

The following must be defined in the mask:

•	 Description
Enter the description of the object – 15 characters max.

•	 Address
Enter the address of the command on the 3456 interface.
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GROUP OF COMMANDS
For the management of climate control it is possible to create a group of commands, selected 
among the ones saved on the 3456 interface.

The following must be defined in the mask:

•	 Description
Enter the description of the object – 15 characters max.

•	 Address
Click to select the commands of the group.

The following must be defined in the mask:

•	 Address
Enter the 3456 interface address.

•	 Command
Enter the command number.
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Advanced Air Conditioning
This section can be used to configure the AC unit objects and the groups of commands that will be 
available in the temperature control/air conditioning function page.
The management is performed directly as if the remote control of the splitter was used, or in any 
cases using the 20 commands saved on the 3456 interface.

AC UNITS
Enter the AC units to configure.

The following must be defined in the mask:

•	 Address
Click to enter the 3456 interface address.
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•	 Probe enabled
Enable/disable the temperature probe.

•	 Probe address
Click to enter the address of the slave probe.

•	 Show Off control
Enable/disable the Off command.

•	 Minimum temperature
Enter the minimum temperature that can be handled by the splitter

•	 Maximum temperature
Enter the maximum temperature that can be handled by the splitter

•	 Step
Enter the desired increase step, choosing between 0,5 °C e 1 °C.

•	 For the Automatic, Cooling, Heating, Dry, Fan, Fan speed presence, Automatic, High, Medium, 
Low, Silent, Swing presence, ON, OFF modes:
Select Yes to make the function available in the corresponding page.
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Favourite commands
Enter the favourite commands for the management of the AC unit.

The following must be defined in the mask:

•	 Description
Enter the description of the object – 15 characters max.

•	 Configuration
Click to set the parameters that will be performed by the command configured.

•	 Temperature
Select the temperature to set.

•	 Mode
Select the operating mode.

•	 Fan speed
Select the fan speed

•	 Fan swing
Select the fan swing mode.



38

GROUP OF COMMANDS
For the management of climate control it is possible to create a group of commands that will be 
performed at the same time.

The following must be defined in the mask:
•	 Description

Enter a description of the group of commands.
•	 Address

Click to select the commands making up the group.

The following must be defined in the mask:
•	 Address

Enter the 3456 interface address.
•	 Temperature

Select the temperature to set.
•	 Mode

Select the operating mode.
•	 Fan speed

Select the fan speed
•	 Fan swing

Select fan swing mode.
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Energy Management
This section can be used to configure the functions that will be available in the “Energy Manage-
ment” page.

Supervision system
This section can be used to configure the system supervision functions that will be available in the 
“Supervision” web page.

Stop & Go
This section can be used to configure Stop & Go switches for the control of the automatic earth leak-
age relay reset function, and other functions.

The following must be defined in the mask:

•	 Description
Enter the description of the object – 15 characters max.

•	 Type
Select the type of switch: Normal, Plus, or Btest.

•	 Address
Enter the switch address.
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LOAD DIAGNOSTIC
This section can be used to set which loads can be subjected to diagnostic, to control their operat-
ing status (advanced actuators only). 

Energy data
This section can be used to configure the parameters that enable displaying the data (consumption/
production) measured on the system, and displayed in the “Energy data” web page.
Several measurement parameters are available:

The following must be defined in the mask:

•	 Description
Enter the description of the load – 15 characters max.

•	 Address
Enter the load address.

Meter type Description Unit

Electricity
It display the electricity consumed or produced by the system. Kw

Water It measures the water consumed.
m3

Connect the meter to a water meter with impulse output.

Gas It displays gas consumption.
m3

Connect the interface to a gas meter with impulse output.

DHW
It measures the hot water consumed. 

KwConnect to a hot water meter or to the corresponding impulse output of a heat 
measurement central unit that can be found in the apartment user modules (in 
case of central heating).

Heating/
Cooling

It displays the calories/frigories measured on the heating/cooling system.

Kw
Connect to a meter with heat impulse output (KWh)
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The configuration is the same for all meters.

The following must be defined in the mask:

•	 Description
Enter the description of the object – 15 characters max.

•	 Address
Enter the meter address

•	 Unit of measure
Select the unit of measure used to display the consumption.

•	 Economic evaluation
Enable/disable the economic evaluation.
Enable this function to create a row in the “Tariff setup” where the user can set the tariff to apply 
to the specific consumption.

•	 Type
Define if the meter is a consumption or a production meter.

The economic evaluation 
is performed based on 
the tariff indicated in the 
“Tariff setup” section.
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Load management
This section can be used to manage the new Load Management system, to display the status of a 
load, force the re-activation based on priorities, set the forcing time, and display the consumption.

The following must be defined in the mask:

•	 Description
Enter the description of the load – 15 characters max.

•	 Priority
Select the load priority

•	 Mode
Set if this is a basic or an advanced load. In the second case the instantaneous consumption can 
also be set.

•	 Economic evaluation
Enable/disable the economic evaluation (Advanced mode only).
The tariff is set in the “Tariff setup” section.

WITHOUT CENTRAL UNIT
The configurations for this mode are the same as the “With Central Unit” mode, with the exception 
of the “Mode” field, which is automatically set to “Advanced”.
The object of this function is to display the consumptions of the loads, also without control/forcing.

WITH CENTRAL UNIT
In this mode, in addition to the above listed functions, it is also possible to reset the load.
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Alarms
This page is always present and active on the devices.

In this section you can customise the descriptions of zones 1 – 8 of the Burglar-alarm system.
The descriptions entered will appear in the messages which the device sends to the Web page every 
time there is a Burglar-alarm or Technical Alarm event in the system
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In the same way you can enable and customise the descriptions for the 9 auxiliary channels used 
to signal technical alarms (e.g. you can enable channel Auxiliary 1 and assign the description “Gas 
leak”).

When the “Camera Presence” field is enabled, if an e-mail is sent by the device following a burglar-
alarm in the zone, a compressed file (.zip format) is also attached to the message, containing the 
images (.jpg) recorded by the camera.

Example: if the intrusion sensor is configured with Z=2 (zone 2) it can automatically activate the 
camera configured in the interface with P=2 (the cameras in the entrance panels are excluded).
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In this mask, for each camera it will be necessary to define:

•	 Description
Enter the camera description (max 15 characters)

•	 Address
Click to select the camera address (00 to 99).

•	 Brightness/Contrast/Color/Quality
Select the picture setting levels (from 0% to 100%)

•	 Staircase light presence
Enable the staircase light presence

•	 Open gate
Enable the open gate presence

Cameras
In this page the cameras (max 20) in the My Home CCTV system which you want to activate from the 
“CCTV” function web page can be enabled and configured.
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Answering machine - settings
The Video door entry answering machine function in the web pages can be enabled and configured 
in this page.

The following must be defined in the mask:

•	 Activation auxiliary channel
Enabling the function, a mask is proposed where you can enter the address of the Automation 
system actuator used to switch ON a “Answering machine active” signal LED. 
Then select the auxiliary activation Channel used by the control device to activate the “Video 
door entry answering machine” locally.

>> Click to enter the SCS address.

•	 Answering machine enabling
Enable/disable the video answering machine function.
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•	 Presentation message
Here you can select one of the pre-recorded files (.wav) or record a new message.

Listen to 
the selected 

message

Record a new 
message

Stop the playing
Or recording of 

the message
Cancel the 
selected file

Store a new 
message

Use the pushbuttons in the window to:
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•	 Number of photos
Select the number of pictures which the video door entry entrance panel camera will send to the 
device. You can choose from 1 to 16 photographs.
If the “Email service” option is active, the pictures will reach the user as attachments to an email 
message.

•	 Email service
Enable this service to receive the e-mail message containing the recorded pictures, selecting the 
Ethernet transmission method.
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Entrance panels
In this section up to 10 video door entry system entrance panels can be enabled. 

For each entrance panel enabled you must configure the Address and activate the Camera pres-
ence
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4.4.2	Notification via e-mail
The sending of alarms for notification via email can be enabled in this page.

Ethernet email enabling

The following must be defined in the mask:

•	 Enabling
Enable/Disable the notification via Ethernet email

•	 Account name
Enter the name of account.

•	 Addressee’s email
Enter the electronic mail address to which the email will be sent

•	 Sender’s email
Enter the sender’s e-mail address
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•	 SMTP server address
Enter the IP address of the mail server in numerical format or in text format (contact the network 
administration to obtain this information).

•	 Authentication type, User, Password, Port, Tls, Start tls, Tls trust file
Enter the correct parameters of your own e-mail account

For Tls enter a certified file.
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Temperature control diagnosis
Enabling this function, when there is a fault in the Temperature control system a message will be 
sent to the e-mail address provided.

5.	Tariff settings On completion of the project configuration, click the forward arrow on the bottom left to set the 
tariffs that will be applied to the consumptions set in the “Energy management” and “Load manage-
ment” sections.

Select the currency, and enter the tariff and the number of decimals to display on the web page.

Select the currency 
to apply

Enter  
the tariff

Enter the number 
of decimals to 
display
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